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概 要 
Pyramixはオプションで CD/SACDマスタリング，デジタルリリース機能をご使用いただけます。 
 
 

CD-Rマスタリング 

Pyramixでは、CDトラックのStart / Stop / Indexマーカーを設定してディスクイメージを作成し、DiscWriteという
別アプリケーションでCD-Rを焼くまたはDDPを作成します。 
 
この方法の利点としては、複数の仮想ディスクを作成することができます。同じ素材を使用して異なるバージョン

の作成することが簡単に行えます。 
  
  

Albumディスクの作成 
CD/SACDタブ画面を開き、Albumタブ内の<New Disc>をダブルクリックしてCDまたはSACDディスクを作成しま
す。必要に応じてDiscタイトルを入力してください。ディスクを作成するとCD Markersが追加できるようになりま
す。 
 
 

CDマーカー 

CDトラックのStartマーカーを設定するには、Playカーソルを任意の位置へロケートしてCursors & Marks > Add 
CD Start Marker to Cursorメニューを選択します。 
 
同様に、CDトラックのStopマーカーを設定するには、Playカーソルを任意の位置へロケートしてCursors & 
Marks > Add CD Stop Marker to Cursorメニューを選択します。 
 
CD Index Markerを追加する場合は、Cursors & Marks > Add CD Index Marker to Cursorメニューを使用し
ます。 
 
これらのCDマーカーは、CD/SACDタブ画面で参照することができ、名前の変更などを行えます。 
 
 

CDマーカーの自動追加 

Groupされたクリップに対して自動でCDトラックのStart/Stopマーカーを設定できます。 
はじめに、CD/SACDタブ画面を開き、Albumタブ内の<New Disc>をダブルクリックしてCDまたはSACDディスク
を作成してください。次に、CDトラックに対応する任意のグループClipを作成します。 
Cursors & Marks > CD Mark Groupsメニューを選択します。または、CD/SACDタブ画面のMarkersメニュー
からCD Mark Groupsメニューを選択します。 
 

 以下のダイアログが表示されます。 
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オプションのRemove existing CD MarkersをチェックしてOKすると、自動でグループClipに対してCDマーカー
が設定されます。 
 
Note: タイムライン上にあるクリップ間のギャップが1秒以下の場合、前のトラック終わりにStopマーカーは設定
せずに、次のトラックのStartマーカーを設定してください。 

  

テキストマーカーからCDマーカーへのコンバート 

テキストマーカーは、CDマーカーへコンバートすることができます。 
 
Markersタブ画面から任意の（または複数の）テキストマーカーを指定して、右クリックメニューからCreate CD 
Discを選択します。これで、CD/SACDタブ画面に新しいCDディスクが作成され、テキストマーカーの位置にCDマ
ーカーが設定されます。この時、最後のトラックとなるクリップの終わりにStopマーカー（Last Stop）が自動で追加
されます。 
 

Note: 最後のトラックにStopマーカー（Last Stop）が設定されていれば、中間のトラックにStopマーカーが設定さ
れていなくてもCDの作成が有効です。 
 
 

CD/SACDタブ画面 

 CD/SACD タブ画面には、マスタリングに必要な機能がすべて備わっています。 
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CD/SACDタブ画面の上段に表示されるTracksリストには、現在選択しているCDまたはSACDディスクのトラック
情報が表示されます。 

  
CD/SACDタブ画面の下段は、Albumエリア，Tree Info/Track Inspectorセクション，PQ Markersリストが3分
割されて表示されます。 

  

Albumセクション 
CD/SACDタブ画面の下段の左側に表示されるAlbumセクションでは、CDおよびSACDアルバムがツリー表示さ
れます。各アルバムの<New Disc>をクリックすると新しいディスクを作成することができます。 
 
アルバムや作成したディスクを選択すると、右側のTree infoにプロパティが表示されます。各フィールドをクリック
することでパラメーターの設定が行えます。詳しくは、後述を参照してください。 
 

Tree Info/Track Inspectorセクション 

Tree Infoタブ 
(Global, CD Header)  
 
General Info 
z Disc Title     CDタイトル名 
z Label    CDプロダクションレーベル名 
z Date     日付 
 
z Customer Name     制作者（社）名 
z Customer Contact    連絡先の名称 
z Customer Phone    連絡先の電話番号 
 
z Master ID Code    CD Identifyingコード（必要に応じて） 
z Ref Code     CDリファレンスコード（必要に応じて） 
z UPC/EAN Code     クリックするとUPC-A / EAN13 codeダイアログを開きます： 

 
Enable UPC/EAN Codeのボックスをチェックすると、UPC/EAN コードが有効になります。 
Code Typeのプルダウンメニューでは、バーコードのフォーマットを選択できます。中央のフィールドに、11桁また
は 12桁の Company prefix と Product Codeを入力します。これに応じて、Checksumには自動計算の結果が
表示され、最後の 1 桁に追加されます。終了後は、OK ボタンをクリックすると結果がフィールドに反映されます。
UPC/EAN Codeは、CD イメージ（PMI）を作成する際に Pyramixの TOC情報に含まれます。 
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z Catalog Number >  フリーテキスト 
 
CD Disk info 
z CD Text Character Set  言語設定 
z CD Text Genre   ジャンル名 
z CD Text Title    タイトル名 
z CD Text Performer   パフォーマー名 
z CD Text SongWriter   ソングライター名 
z CD Text Composer   コンポーザー名 
z CD Text Arranger    アレンジャー名 
 
Markers/Tracks Relation 
z Markers are linked to   クリックするとプルダウンメニューが表示され、以下を選択できます。 

<Independent>，Any Track，any Track without Group，Main，Sources 
  

Track Inspectorタブ 
Tree Infoタブの右側にあるTrack Inspectorタブでは、Tracksリストで選択したトラックの情報を表示し、データの
編集を行うことができます。 
 
z Name   トラック名が表示されます 
z # (Number)    ディスクのはじめから昇順に付けられたトラック番号が表示されます 
z Pause   トラック間のPauseタイムの表示と編集が行えます（CDフレーム） 
z Start   トラックのStartタイムの表示と編集が行えます（CDフレーム） 
z End   トラックのEndタイムの表示と編集が行えます（CDフレーム） 
z Length   トラックの長さの表示と編集が行えます（CDフレーム） 
z Start Offset   Startオフセットの値の表示と編集が行えます（CDフレーム） 
z Use Offset   マーカーのオフセットを有効にするかどうか、Yes/Noで設定できます 
z ISRC   フィールドをクリックするとISRCコードを編集できます 
z Copy   コピープロテクトを有効にするかどうか、Yes/Noで設定できます 
z Comment   注意事項などを記入できるコメント欄です 
 
 
CD Text Info 
z Genre  
z Title  
z Performer  
z Song Writer  
z Composer  
z Arranger  
 
CD Text Infoは、CDディスクのCD-TEXT情報を編集することができます。各フィールドをクリックすることでパラメ
ーターの入力設定が行えます。 
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PQ Markersセクション 
CD/SACDタブ画面の下段の一番右側に表示されるPQ Markerセクションでは、設定したすべてのPQマーカーが
表示され、必要に応じて編集することができます。オーディオ編集ではなく、PQのみが修正されます。PQマーカー
は、右クリックメニューを使用して、カット/コピー/ペーストすることができます。 

  
PQ Markers内のリストは、CDディスクまたはSACDディスクのエリアの選択とリンクして、関連するPQマーカーを
表示します。 
 
リストの一番上に表示されているClick here to add a new CD Markerをクリックすると、新しいCDマーカーを追
加することができます。Nameフィールドにテキストカーソルが表示されるので、PQマーカーの名前を入力してエン
ターしてください。登録したPQマーカーは、Name以外のフィールドもクリックして編集できます。 
 

Fields 

Name PQマーカーの名前です。CD Mark Group機能を使用して自動作成したマーカ
ーは、名前の最後に“ * ”が表示されます。 

# (Number) PQマーカーの番号です。表示のみで変更はできません。 
StopマーカーはStartマーカーと同じ番号になります。 

Type マーカーの種類 
Time マーカー位置のタイム情報 
Offset マーカーのオフセット情報（無効に設定している場合はグレーアウト表示） 
Use Offset マーカーのオフセット情報を有効にするかどうかの設定（Yes/No） 

  

Tracksセクション 
CD/SACDタブ画面のリストの一番上に表示されているTracksセクションでは、CDトラック情報の表示と編集が行
えます。ここで修正した情報は、自動的に編集トラックへ反映されます。例えば、Pauseタイムを4秒から6秒へ修
正した場合、それ以降のトラックは自動的に2秒（差分）後ろへリップルします。 

  
Name CDトラックの名前の表示と編集が行えます。 
# (Number) ディスクのはじめから昇順に付けられたトラック番号が表示されます。 

クリックするとトラック番号を入れ替えることができます。 
Pause トラック間のPauseタイムの表示と編集が行えます。（CDフレーム） 

一番はじめのトラックのPauseタイムは、常に00:00:00:00となります。 
それ以降のトラックは、Red Book仕様書の規定により2秒のPauseタイムが最終
のTOCデータで自動追加されます。例外としてGhostトラックを使用する方法があ
りますが、詳しくは後述をご参照ください。 

Start トラックのStartタイムの表示と編集が行えます。（CDフレーム） 
修正すると、現在のトラックと以降のトラックがリップルします。 

End トラックのEndタイムの表示と編集が行えます。（CDフレーム） 
修正すると、以降のトラックがリップルし、Lengthにも反映されます。 

Length トラックの長さの表示と編集が行えます（CDフレーム） 
修正すると、現在のトラックと以降のトラックがリップルします。 

Start Offset Startオフセットの値の表示と編集が行えます（CDフレーム） 
Use Offset Start/Stop/Indexマーカーのオフセットを有効にするかどうか、Yes/Noで設定で

きます。Start/Stop/Indexのオフセットを個別に設定したい場合は、PQ Markers
セクション内で調整してください。 
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ISRC フィールドをクリックするとISRCコードを編集できます。 
編集した値は、Track InspectorタブのISRCフィールドにも反映されます。 
また、ISRC > Createメニューを使用すると、All Settings > Application > 
CD/SACDページの“ISRC default parameters”の値を参照してISRCコードを
自動生成することもできます。（ISRCコードの例：GBZZZ0500001） 

Copy コピープロテクトを有効にするかどうか、Yes/Noで設定できます。 
Comment 注意事項などを記入できるコメント欄です 
Genre ジャンルを設定します。テキスト入力またはプリセットリストから選択することが

できます。 
  

CD Textフィールド 
各フィールドをクリックすることで編集が行えます。編集した情報は、Track InspectorタブのCD Text Infoフィール
ドに反映されます。また、CD-Text > Set Track～メニューを使用することで、Tree InfoタブのCD Disc Infoフィー
ルドに入力した値をそのままコピーすることもできます。 

  
CD Text Title 
CD Text Performer 
CD Text Song Writer 
CD Text Composer 
CD Text Arranger 
 
 

CD/SACDタブ画面のメニュー 
Discs 

Create SACD Disc 
From CD Disc 現在のCDディスクの内容からSACDを作成します。 

Create CD Disc 
From SACD Disc 現在のSACDディスクの内容からCDを作成します。 

  

Markers 

CD Mark Groups クリップまたはクリップグループから自動的にPQマーカーを生成します。 
Add Start Marker カーソル位置にStartマーカーを追加します。 
Add Index Marker カーソル位置にIndexマーカーを追加します。 
Delete Selected Marker(s) 選択したマーカーを削除します。 
Delete Selected Track(s) 選択したトラックを削除します。 

（Clip，マーカー，オートメーションなどを含む） 
Clear All Markers すべてのPQマーカーを削除します。 
Validate name PQマーカーの名前をチェックして自動修正します。 

CD Mark Group機能で作成したマーカーの名前に付いている“ * ”など
は削除されます。また、最後のトラックのStopマーカーには、名前の最後
に自動的に“stop”が付加されます。 

Validate PQ 設定したPQコードがRed Book仕様書に適合しているかどうかのチェック
と修正を実行します。結果はUndoできます。 
詳しくは、後述のRed-Book Validationのページをご参照ください。 
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Offsets 

Show Offset メニューを選択するごとにOn/Offがトグルで切り替わります。 
有効なオフセットの値を含めた時間をPQマーカーの最終ポジションとして
反映させます。TOC上は常に有効となっているオフセット値をPQコードに
反映して表示します。よって、この機能をOnにすることで、タイムライン上
でPQマーカーのリアルなポジションを表示させることができます。 

Copy First Start 選択しているCDマーカーにAll Settings > CD/SACD内で設定されている
Offset before First Startの値を適用します。 

Copy Last Stop 選択しているCDマーカーにAll Settings > CD/SACD内で設定されている
Offset after Last Stopの値を適用します。 

Copy Start 選択しているCDマーカーにAll Settings > CD/SACD内で設定されている
Offset before Startの値を適用します。 

Copy Stop 選択しているCDマーカーにAll Settings > CD/SACD内で設定されている
Offset after Stopの値を適用します。 

  

ISRC  

Create All Settings > Application > CD/SACDページの“ISRC default 
parameters”の値を参照して、選択しているトラックのISRCコードを自動
生成します。1つ以上のトラックを選択している場合、ISRCコードは昇順
に付番されます。（ISRCコードの例：GBZZZ0500001） 

Inc. Selection 選択しているトラックのISRCコードの付番のみを作成します。 
1つ以上のトラックを選択している場合、昇順に付番されます。 

Validate ISRC 設定したISRCコードがISRCの様式に適合しているかどうかのチェックと
修正を実行します。結果はUndoができます。 

  

CD-Text 
Import > Cue Sheet File (.CUE) Cueシートファイル（.cue）をインポートします。 
Export > CD-Text File (.TXT) Cueテキストファイル（.txt）をエクスポートします。 
Set All Track CD-Text 
from Disc info 

選択しているトラックのCD Textフィールドに、Disc Infoで設定されている
CD Text情報のすべての値をコピーします。 

Set Track Performer 
from Disc Info 

選択しているトラックのCD Text Performerフィールドに、Disc Infoで設
定されているCD Performerの値をコピーします。 

Set Track Song Writer 
from Disc info 

選択しているトラックのCD Text Song Writerフィールドに、Disc Infoで設
定されているCD Song Writerの値をコピーします。 

Set Track Composer 
from Disc info 

選択しているトラックのCD Text Composerフィールドに、Disc Infoで設
定されているCD Composerの値をコピーします。 

Set Track Arranger 
from Disc info 

選択しているトラックのCD Text Arrangerフィールドに、Disc Infoで設定
されているCD Arrangerの値をコピーします。 

Set Track Title from Track Name 選択しているトラックのCD Text Titleフィールドに、Track Nameをコピー
します。 
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SACD Text 
Import >  Philips Album file (.lbm) 

Sony STT Disc file (.mts) 
Export >  CD-Text File (.TXT) 
Copy Album Info to selected Disc Info 
Set Track Performer from Disc Artist 
Set Track Title from Track Name 

  

View 

Show CD Player CD Player画面を開きます。詳細は別章をご参照ください。 
Display TOC... TOC Displayダイアログが開きます。左側には現在のProjectで作成した

すべてのCDアルバムとSACDアルバムのディスク情報が表示されます。
任意のディスクを選択すると、右側のTOC情報の表示が切り替わりま
す。 

  
  

Default Settings 

Settings > All Settings > Application > CD/SACDページにてCD OffsetとISRCのデフォルト値を設定できま
す。 
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CD Offset default parameters 
PQマーカーのオフセット時間を0に設定したい場合は、これらのパラメーターにチェックしてください。 

  
CD Start Offset Enabled 
CD Index Offset Enabled 
CD Stop Offset Enabled 
 
下記の設定の値は、レジスタに数値を直接入力するか、右端の▲/▼ボタンで微調整することができます。 
 
Offset before first Start 一番始めのStartマーカーに、ネガティブオフセットを適用します。 
Offset before Start 一番始めのStartマーカーを除いたすべてのStartマーカーに、ネガティブオフセ

ットを適用します。 
Offset after stop 最後のStopマーカーを除いたすべてのStopマーカーに、ネガティブオフセットを

適用します。 
Offset after last stop 最後のStopマーカーに、ネガティブオフセットを適用します。 
Offset before Index Indexマーカーに、ネガティブオフセットを適用します。 

  

ISRC default parameters 
これらのパラメーターは、CD/SACDタブ内のISRC > Create および ISRC > Inc Selectionメニュー（または、
Tracksセクション内の右クリックメニュー）を使用する際に、ここで設定した値を参照します。 
 
Country Code 2文字（例：GB, SW, FR） 
Producer 3文字（例：W01） 
Year of Reference 2桁（例：02） 
Designation Code 5桁（例：00012, 80010） 
Increment by 上記Designation Codeを自動で増分させます。デフォルト値は“1”です。 

  
Show CD Player 

 
CD/SACDタブ内のView > Show CD Playerメニューを選択すると、CDの再生をシミュレーションできるCD 
Player画面が表示されます。CDプレーヤーでは、マーカーのオフセットの有り無しに関わらずシミュレーションをす
ることができます。 
 
設定したオフセットをマーカーへ反映させたい場合は、Offsets > Show Offsetメニューを選択するか、Trackセク
ション内で右クリックメニューからShow Offsetを選択してください。 
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CDプレーヤーには標準の再生機能（PLAY，STOP，NEXT，PREV，FFWD，REW）およびいくつかの特別な機
能が備わっています： 

  
Preroll / Postroll 各ボックスをクリックしてプリロール/ポストロール値（sec）を入力できます 

 
前のトラックへスキップ（PREV） 

 
次のトラックへスキップ（NEXT） 

 
停止（STOP） 

 
再生（PLAY） 

 
巻き戻し（REW） 

 
早送り（FFWD） 

 
Play Transitionボタンは、現在表示されているトラックのStartマーカー前後をプリロ
ール/ポストロール値を含めて再生します。プリロール/ポストロール値は、CDプレーヤ
ー上で設定を変更することができます。 

 
Play All Transitionsボタンは、すべてのCDトラックをプリロール/ポストロール値を含
めて再生します。 

 

Trackボタンは、クリックすると4つの異なる表示オプションを設定できます。（All，All 
Rem，Track，Tr Rem）CD全体またはトラック毎の経過時間や残り時間を表示させま
す。 

 
CDフレームの表示/非表示を切り替えます 

 
Rnd 

  
  

Ghost Track 
通常CDの最初のトラックを開始するためには2秒のポーズが必要です。Pyramixでは、この最初のトラックの手前
にGhostトラックを作成することができます。Ghostトラックを作るには、一番初めのStartマーカーの前にIndexマー
カー（#0）を追加します。このIndexマーカーを調整することで、最初のポーズ時間を設定することができます。 
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Red-Book Validation 
Markers > Validate PQメニューでは、設定したPQコードがRed Book仕様書に適合しているかどうか、以下の内
容をチェックして自動修正を行います。 

  
z トラック間のポーズが1秒以内の場合、ポーズを削除します。 
z トラックの長さが4秒以下の場合、4秒に修正します。それ以降のトラックは後ろへリップルします。 
z トラックが99以上ある場合は、99までに修正します 
z ISRCコードが不正確な場合は削除します 
z UPC/EANコードが不正確な場合は削除します 
 
これらの修正結果は、Undoコマンドで元に戻すことが可能です。 
 

  

DDPインポート 
DDPテープまたはDDPファイルから、Project > Import > DDP Importメニューを使用して、プロジェクトへデータ
をインポートすることが可能です。インポートしたデータは、新しいCDイメージファイルを作成してCDに焼いたり、
新しいDDPテープを作成したりすることができます。 
 
 

CDイメージファイル / SACDエディットマスターのインポート 
CDイメージファイルまたはSACDエディットマスターから、オーディオとPQマーカーをンポートできます。Project > 
ImportメニューからCD Image File / SACD Edited Master Importを選択すると以下の画面が開きます。 
 

 
  

各…ボタンで、ファイルブラウザ画面が開くので任意のファイルを選択します。 
  
  

画面下にあるチェックボックスは、データのインポート処理をどのように行うかを設定できます。 
 
Place in Timeline タイムラインの適切なトラックにオーディオデータをインポートします。 
Add Track Group 関連するオーディオトラックをTrackグループにしてインポートします。 
Add Disc & PQ markers CDタブへDiscが追加され、PQマーカーもインポートします。 
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SACDファンクション 
CD/SACDタブのTracksエリアを右クリックして、以下のメニューを選択します。 
 

lbm... 

 
  

Import... / Export... 
ブラウザ画面が開き、保存先または呼び出すSACDテキストの.lbmファイルを指定します。 
 
mts... 
ブラウザ画面が開き、保存先または呼び出すSACDテキストの. mtsファイルを指定します。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 

Pyramixユーザーマニュアル  

CDイメージファイルのエクスポート 
  

Project > Generate CD Image / SACD Edited Masterメニューを選択すると、下図のGenerate CD Imageダ
イアログが開きます。 
 

 
  

画面左からCDディスクを選択してください。 
 

Target Settings 
Image Format 
ドロップダウンリストから必要なフォーマットを選択します。 
 
CD Image (Red Book) Red Book仕様書に準拠したCDディスクイメージを作成します。 
Digital Release Album Publishingのフォーマットでオンラインリリース用のデータのみを作成した

い場合に選択します。詳しくは後述の“Album Publishing”の章をご参照ください。
SACD Edited Master - Render Mode（DSDまたはDXDプロジェクトでのみ選択可） 
SACD Edited Master - Mixing Mode 

  
Image Name 
イメージの名前をタイプ入力します。 
 
Image Location 
現在マウントされているMediaフォルダをリストから選択できます。新しい場所を指定するには、…ボタンをクリック

してブラウズ画面を開いてください。 
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Processing 
Real Time 
リアルタイムでCDイメージを作成したい場合、またはモニターしながらCDイメージを作成したい場合は、ボックス
にチェックを入れてください。 
 

SRC Filter Type 
音声データのサンプリングレート・コンバージョンが必要な場合に利用可能なオプションです。このオプションは

Merging technologies社のHeptaConテクノロジーを使用しています。 
 
ドロップダウンリストからフィルターの種類を選択してください。 

 
  

Dithering 
Note: ディザリングの必要がない場合、ミキサー内で右クリックメニューを表示してSettings > Dithering…メニュ
ーを開いて設定を無効にしてください。 
 
ディザリングの設定は、以下の2種類から選択できます。 
 
Use Mixer Settings (default) 
ミキサーのSettings > Dithering…メニューで設定されたディザー処理を適用します。 
 
Use 16 bits WLC/Noise Shaper 
ドロップダウンリストからノイズシェーピングのクォリティを選択します。 
高音質の設定は良質な結果を得られますが、処理時間は長くかかります。 

 
 

Controllers 
Offline Controllers 
イメージ作成中に外部コントローラーを使用してモニターボリュームやフェードアウトなどを操作したい場合は、ボッ

クスのチェックを外してください。 
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Album Publishing 
CDイメージを作成すると同時にオンラインアルバムを作成したい場合は、Enableにチェックを入れてください。
SettingsボタンをクリックするとAlbum Publishing optionsのプロパティが開きます。 
詳しくは後述の“Album Publishing”の章をご参照ください。 
 
 

Mixer Sources 

表示リストから適切な出力バスを2つ選択してください。Ctrlキーを押しながらクリックで選択できます。 

 
  

選択した出力バスの数が足りなかったり多すぎたりした場合、Generate Imageボタンをクリックした際に以下の
エラーが表示されます。もう一度Mixer Sourcesの設定を確認してください。 
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CD Cueシート 

  
CD Cueシートファイルは、CDまたはDVDのトラックレイアウト等がどのように展開されているかを示すメタデータ
ファイルです。Cueシートは、テキストファイルで一般的に.cueという拡張子で保存されています。Cueシートは、は
じめにCDRWINによって作成され、現在は多くのディスクオーサリングソフトやメディアプレーヤーで使用されてい
ます。  

  
音楽CDでは、タイトル，アーティスト名，トラック番号，使用するオーディオファイルの名前などをCueシートに保存
できます。多くの場合、MP3，WAV，BINファイルなどが使用されますが、アプリケーションによっては他のファイル
もサポートしています。 

  
また、Cueシートはイメージファイルなどに関連したあらゆるタイプのCDでも使用されています。イメージファイル
の場合、一般的に.binという拡張子で保存されています。 
 
Pyramixでは、イメージファイルに.PMI、Cueシートファイルに.cueの拡張子を使用します。 
 
 

Cueシートファイルのコンテンツ 

 Cueシートファイルは、メモ帳などのテキストエディターから開くことができます。 

   
  

Export 
CDのCueシートのファイル（.cue）は、CDRWIN仕様書に従って.pmiディスクイメージの書き出しと同時に出力さ
れます。 
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音楽CD Cueシートの互換性 

以下は、主な CD ライティングソフトによる Cueシートの互換性となっています。 

 
  

Note: * Roxio Toast v9にAudio CD Cueシートをインポートする場合 
 
z PMIファイルの拡張子.PMIから.BINへ書き換える必要があります。 
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Album Publishing 

  

Digital Release 

概 要 

Pyramix V7 SP1より、オンラインアルバム用のデータが作成できる「Album Publishing」機能が新たに追加され
ました。 
 
サポートしているフォーマット： 
z FLAC（可逆圧縮） 
z Ogg Vorbis（非可逆圧縮） 
z WAVE（非圧縮） 
z AIFF（非圧縮） 
z MTFF（非圧縮または可逆圧縮） 
z LC-AAC（非可逆圧縮） 
z MP3-ABR（非可逆圧縮） 

  
同時に出力したいフォーマットを複数選択することができ、フォーマット毎にサンプリングレート周波数やワードレン

グス、圧縮クォリティを設定できます。 
  
  

Album Publishing 機能は、以下の４通りの方法で使用できます； 
  

Generate CD Imageウィンドウ内にて 
z PMI CDイメージの作成に追加して出力する。 
z Image Format設定で“Digital Release”を選択して単独で出力する。 

  
DiscWriteアプリケーション上にて 
z PMI CDイメージまたはDDPファイルのソースからディスクを作成する際に追加して出力する。 
z PMI CD イメージまたは DDP ファイルのソースから“Album Publishing”を単独で出力する。 

  
  

ハイサンプリングのプロジェクトの場合は、PMI CDイメージを作らずにTarget Format > Image Formatのドロップ
ダウンメニューからDigital Releaseを選択してデータを出力すると高品質な結果が得られます。 
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Album Publishing Settings 

 
  

CD Imageの作成とPublish Album 
PMI CDイメージの作成に追加して出力する場合はGenerate CD Image / SACD Edited Master画面において、
Album PublishingのEnableにチェックしてください。SettingsボタンをクリックするとAlbum Publishing 
optionsのプロパティが開くので、必要な設定を行ってOKします。Generate Imageをクリックするとプロセスが始
まります。 
 

Digital Release 
ダウンロード/ストリーミングによるオンラインリリースを目的とする場合、Target SettingsのImage Formatドロッ
プダウンメニューからDigital Release (Stereo)を選択してください。 
 
 
Note:  
ターゲットを CD Image (Red Book)にして Album Publishing にチェックするよりも、ターゲットで Digital 
Releaseを選択した方が不必要な 44.1kHz/16bitへの変換を回避できます。 
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Target Settings 
Image Format 
 
Digital Release (Stereo) 
 
Image name 
MTFFイメージファイルはデフォルトでCD Albumと同じ名前が付きます。変更する場合は、フィールド内で編集で
きます。 
 
Image Location 
MTFFイメージファイルの保存先を選択します。 
ドロップダウンリストから現在マウントされているフォルダを選択するか、...ボタンをクリックしてChoose a media 
folder to mountダイアログを開いて、任意の場所を指定します。 

  
Note: もしイメージファイルを削除したい場合、Windowsのファイルブラウザ上から保存場所へ移動してファイル
を削除してください。 
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Album Publishing 

Album Publishingセクションの Settingsボタンをクリックして Album Publishing options Propertiesダイア
ログを開き、必要な設定を行って OK します。Generate Imageをクリックするとプロセスが始まります。 

  

Settings 
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Output Formats 
指定した出力フォーマットがここにリスト表示されます。左側にチェックを入れたフォーマットでアルバムを作成しま

す。同じフォーマットの異なる設定など、複数選択して同時に作成することが可能です。 
例えばFLACとWAVバージョンの2種類を作成したい場合、それぞれ異なった設定で同時に作成できます。 
 
Output Formatsのリストからフォーマットを選択すると、右側にフォーマット毎に異なる設定が表示されます。上
記の画面は、選択されたFLAC-192kの詳細設定が表示されています） 
 

Adding Output Formats 
サポートしているフォーマット： 
z FLAC（可逆圧縮） 
z Ogg Vorbis（非可逆圧縮） 
z WAVE（非圧縮） 
z AIFF（非圧縮） 
z MTFF（非圧縮または可逆圧縮 Merging Technologiesファイル・フォーマット） 
z LC-AAC（非可逆圧縮 Low Complexity Advanced Audio Coding） 
z MP3-ABR（非可逆圧縮）MP3 Average Bit-Rate compression 平均ビットレート) 

  
Addボタンをクリックすると、Add New Output Formatダイアログが開きます。 

 
Format ドロップダウンリストから必要なフォーマットを選択します。 
Sampling Rate デフォルトはNo Changeとなっており、Projectで設定しているサンプリングレートを使

用します。変更する場合は、ドロップダウンリストから任意のサンプリングレートを選択

します。 
Wordlength デフォルトはNo Changeとなっており、Projectで設定しているワードレングスを使用し

ます。変更する場合は、ドロップダウンリストから任意のワードレングスを選択します。 
  

Settings for (*) export 
One contiguous 
audio file + Cue File

アルバム全体で1つのオーディオファイルとCueファイルを作成します。 

Unicode (UTF8) 
encoded CUE Sheet

UnicodeのCueシートも作成します。 

One audio file 
per track 

アルバムのトラック毎にオーディオファイルを作成します。 

Include Pause CDポーズが含まれます。デフォルトでチェックされています。 
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Compression Setting : スライダーによって圧縮設定を調整できます。 
 
FLAC 0 (Fast Encoding)～8 (Best compression)の間で調整できます。 
Ogg Vorbis ~64kbps (Lower quality- smaller files)～500kbps (Higher quality - bigger 

files)の間で調整できます。 
MTFF Not Compressed または Lossless compressedを選択できます。 
LC-AAC 8kbps (Lower quality- smaller files)～320kbps (Higher quality - bigger files) 

の間で調整できます。 
MP3-ABR 32kbps (Lower quality- smaller files)～320kbps (Higher quality - bigger files) 

の間で調整できます。 
 
 
File Naming and Destination 
 
Contiguous audio files convention : 
フィールドとタグを入力することで名前付けを指定できます。名前付けはDisc infoを参照して行われます。 
 
z <DiscTitle>  Album title 
z <DiscPerformer> Album artist 
z <DiscSongwriter> Album songwriter 
z <DiscComposer> Album Composer 
z <DiscArranger>  Album Arranger 
z <UPCEAN>   Album UPC/CEAN code 
z <SampRate>  Target Sampling Rate 
z <Wordlength>  Target Resolution 
z <DiscNum>   Disc Number 
 
?ボタンは使用可能なネームタグをポップアップ表示します。 

  
  

One file per track convention : 
フィールドとタグを入力することで名前付けを指定できます。名前付けはDisc/Track infoおよびCD-Text/Track 
Numberを参照して行われます。 
 
z <DiscTitle>  Album title 
z <DiscPerformer> Album artist 
z <DiscSongwriter> Album songwriter 
z <DiscComposer> Album Composer 
z <DiscArranger> Album Arranger 
z <UPCEAN>  Album UPC/CEAN code 
z <TrackTitle>  Track Name 
z <TrackPerformer> Track artist 
z <TrackSongwriter> Track Songwriter 
z <TrackComposer> Track Composer 
z <TrackArranger> Track Arranger 
z <SampRate>  Target Sampling Rate 
z <Wordlength> Target Resolution 
z <DiscNum>  Disc Number 
z #,## or ###  Track number 
 
?ボタンは使用可能なネームタグをポップアップ表示します。 
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Output Folder : 
出力先パス情報を示します。...ボタンをクリックするとブラウザが開いて出力先のフォルダを指定/作成できます。 
 
Note: 出力先が指定されていない場合は、デフォルトでC:¥User¥<login name>¥My Music¥<filename(s)>に出
力されます。 

  
 

 Misc 
Generate Disc Summary XML file（Abeille Musique, HDTracksなどのサイトで必要なファイルです） 
ボックスにチェックを入れると、Abeille MusiqueやHDTracksなど特定のミュージックストアが指定するXMLファイ
ルを追加作成します。 

  
 
OK 
OKをクリックすると変更した設定を適用してダイアログを閉じます。 
 
Cancel 
Cancelをクリックすると変更した設定を無効にしてダイアログを閉じます。 
 
 
 

アルバムの作成 

Generate CD Image / SACD Edited Master画面の右下でGenerate Imageをクリックするとプロセスが始まり
ます。 

  
作成したファイルは指定したパスの場所に保存されます。メタデータは、CDイメージTOCおよびCDテキスト情報
をベースに書き込まれます。 
 

メタデータのエキスポート 

出力されたメタデータは、CD Authoring/CD Textフィールドをソースにした内容を含みます。 
 

エキスポートされるフィールド： 

z Encoding Tool 
z Track title 
z Artist (per track) 
z Album artist (disc artist) 
z Composer 
z Album name 
z Track number/Total number of tracks 
z Disc number / Total number of discs 
z ISRC code 
z UPC/EAN code (as Barcode and Catalog Number) 
z Label code (also as comment) 
z Year 
z Genre 
z Comments 
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 タグ仕様 
z AIFF / MP3：  ID3v2 
z Ogg Vorbis / FLAC： Xiphコメント 
z M4A：  atom（Quicktimeメタデータ） 

  
タグ仕様のマッピングはMusicBrainz Picardと同様です。 
http://wiki.musicbrainz.org/PicardTagMapping 

CD/SA  
  

エクスポートファイルの例： 
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DiscWrite（ディスクライト） 

 
DiscWriteは、Pyramix Virtual Studioのバンドルでインストールされるアプリケーションです。 
 
CDイメージをCD-Rディスクへ書き込んだり、DDPイメージファイルをDDPフォルダやDDPテープドライブへ書き込
んだりするためのアプリケーションです。 
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Source 

Pyramix CD Imageのドロップダウン・メニューでは、新たにCD-RやDDPファイルを作成するためのソースとなる
CDイメージファイル，インストールされているオプティカルドライブ，Umaticテープ，既存のDDPマスターファイル
などを選択できます。 

  
  

Source - Pyramix CD Image 

 
  

SourceにPyramix CD Image選択すると、Open Image...ボタンが表示されます。Open Image...ボタンをクリッ
クするとファイル参照のダイアログが開くので、任意のCDイメージファイルを選択することができます。 
 
Edit...ボタンをクリックすると、Image Editorダイアログが開きます： 

 
 
CD-Textは自由に編集できます。 

  
Restore Original 
ダイアログ内で変更したパラメーターを全て元に戻します。 
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Source - CD Drive 

 
ソースにCD: ....を選択した場合、EjectボタンとSettings...ボタンが表示されます。 

  
  

Eject 
選択したソースドライブのトレイを開きます。Ejectボタンの右端からは、以下のドロップダウン・メニューを選択でき
ます。 
 
Retract 選択したソースドライブのトレイを閉じます。 
Disk Info ディスク情報を読み込んでResultsボックス内に表示します。 
Drive Info ドライブ情報を取得してResultsボックス内に表示します。 

  
  

Source - U-Matic Tape 
Sony PCM-1630マスターテープをインポートすることができます。詳細は別章をご参照ください。 
 
Info 
Infoの欄には、オプティカルドライブの読み込みスピードまたはイメージファイルの保存先パス情報を示します。 
 
 
Target 
Targetのドロップダウン・メニューでは、インストールされているCD-RまたはDDPドライブ，DDP Folder，Album 
Publishingのいずれかを選択することが可能です。 
 
DDP Folder 
ターゲットにDDP folderを選択した場合、Recordボタンの右端から以下のドロップダウン・メニューを選べます。 

 
  

Verify ベリファイを出力します。 
Select Folder... ブラウザを開いて保存先のフォルダを指定します。 
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Settings... 
このボタンをクリックするとDDPの設定情報とオプションを含むSettingsウィンドウが開きます。 
 
Album Publishing 
ターゲットにAlbum Publishingを選択した場合、RecordボタンはLaunchボタンに変わります。 

 
Settings...ボタンをクリックすると、Album Publishing optionsのプロパティ画面が開きます。詳細は“Album 
Publishing”の章を参照してください。設定が完了したら、Launchボタンでアルバムのエキスポートを開始しま
す。 

  
  
  
 CD-R/CD-RW 

ターゲットにCD-R（RW）を選択した場合、Recordボタンの右端から以下のドロップダウン・メニューを選べます。 

 
  

Eject 選択したターゲットドライブのトレイを開きます。 
Retract 選択したターゲットドライブのトレイを閉じます。 
Disk Info ターゲットディスクから情報を読み込み、Resultsボックス内に表示します。 
Fix Disc Track at Onceで書き込んだディスクをCDプレーヤーで読み込めるように必要情報を

書き込みます。 
Erase Disc ディスクの内容を消去します 
Drive Info ドライブ情報を取得してResultsボックス内に表示します。 

  
Settings... 
このSettings...ボタンは、適切なオプティカルドライブまたはイメージファイルが選択されていないとグレーアウトし
ます。Settings...をクリックするとSettingsダイアログボックスが開きます。セッションの必要に応じて設定を行って
ください。通常はデフォルト設定のままで特に問題ありません。書き込み方式“CD Write Method”の設定は
“Disc At Once”が設定されています。互換性の高い“Disc-at-Once”方式をご使用ください。 

  

Record 
Recordボタンをクリックするとレコーディング処理を開始します。 
進行状況などのレポートはResultsボックスに表示されます。 
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Info 

Targetドライブの書き込みスピードを表示します。DDPフォルダへファイルを書き込んでいる場合は、出力先のパ
ス情報を表示します。また、現在の書き込み形式の設定（Track At OnceまたはDisk At Once）を表示します。 
 

Status 
レコーディング・デバイスの状態や処理状態を表示します。 
 
Progress 
レコーディングの進行状況をバーグラフで表示します。 
 
Buffer 
レコードバッファーの状態を表示します。 
 

Results 
現在実行している処理についての状況など、様々な情報を表示します。 
 
 

Table Of Content 
TOCの詳細が表示されます。 
 
Print TOC... 
Print Optionsダイアログが開きます。プリンタ情報の設定とTOCの印刷が行えます。 

  
Save TOC... 
ファイル参照のダイアログが開き、TOCに名前を付けて任意のフォルダに保存することができます。 
 
Select Report... 
ファイル参照のダイアログが開き、TOCのレポート形式を選択することができます。 
 
Design Report 
Report Designerアプリケーションが開き、TOCのレポート形式を自分でデザインすることができます。 

  
Note: 
オプティカルドライブのメーカーが提供している最新のファームウェアやドライバをご使用ください。 
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CDテキスト 

CDテキストは“Disc At Once”の書き込み方式のみに対応しています。 
 
CD-Textの互換性を確認するには、Targetエリア内で適切なドライブを選択し、Recordのドロップダウン・メニュ
ーからDrive Infoを選択します。Resultsボックス内に表示された情報をスクロールして、Supported write 
methods:セクションで“Writing CD-Text (audio, disc at once): Yes.”となっていることを確認してください。 

  
  

CD-Rを焼く 
DiscWriteを起動します。（通常PyramixをインストールするとDiscWriteアイコンがデスクトップ上に作成されま
す）DiscWriteでCD-Rを焼く前に、あらかじめCDイメージを作成しておきます。 
 
1. SourceセクションでOpen Image...ボタンをクリックし、任意のCDイメージファイルを選択します。

（.img，.pmi） 
 
2. Targetセクションのドロップダウン・メニューからCD-Rデバイスを選択します。 
 
3. TargetセクションのSettings...ボタンをクリックし、CD-R Settingsダイアログボックスを開きます。セッション

の必要に応じて設定を行ってください。通常はデフォルト設定のままで特に問題ありません。書き込み方式

“CD Write Method”の設定は“Disc At Once”が設定されています。 

 
4. CD-R Settingsで必要な設定を行ったらOKボタンでウィンドウを閉じ、Targetセクション内のRecordボタンを

クリックするとCD-Rを焼き始めます。 
 
 



 
 
 

Pyramixユーザーマニュアル  

DDPマスター 
Note: 上記の例のとおり、PyramixはDDPマスターに対応しており、データロスなくコピー，変換，複製，チェック，
アーカイブ，FTPへの送信などに利用することができます。 
 

Red Bookとの互換 
Red Bookとの互換性を確保するには、Settings…を開いて”File Option For CD”の値を"Contiguous"に設定し
なければなりません。 
 

CDコピー 
ハードウェアの用意があれば、ソースのCD-ROMドライブからターゲットのCD-R/RWドライブへCDを直接コピー
することができます。 
 

TOCs 

Print TOC... 現在のTOC情報を選択しているレポートフォーマットでプリントします。 
Save TOC... 現在のTOC情報に名前を付けて任意のフォルダにテキスト形式（.txt）で保存します。 
Select Report... ファイル参照のダイアログが開き、TOCのレポート形式（*.lst）を選択できます。 
Design Report... Report Designerが起動します。マニュアル（英語版）はオンラインでダウンロード可

能です。http://www.combit.net/en/list-label-downloads 
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